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About Us 
Hexagon Geospatial helps you make sense of the dynamically changing world. Hexagon 
Geospatial provides the software products and platforms to a large variety of customers through 
direct sales, channel partners, and Hexagon businesses, including the underlying geospatial 
technology to drive Intergraph Security, Government & Infrastructure (SG&I) industry solutions. 
Hexagon Geospatial is a division of Intergraph Corporation. 

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including 
local, state and national mapping agencies, transportation departments, defense organizations, 
engineering and utility companies and businesses serving agriculture and natural resource 
needs.  Our portfolio enables these organizations to holistically understand change and use 
information to make mission and business-critical decisions.   

TECHNOLOGY. Our priority is to deliver products and solutions that make our customers 
successful. Hexagon Geospatial is focused on developing leading-edge technology that is easily 
configurable. Through extensible, scalable and collaborative products, we enable you to 
transform multi-source content into dynamic and actionable information. We are constantly 
re-conceptualizing and improving our products. 

PARTNERS. As an organization, we are partner-focused, working alongside our channel to 
ensure we succeed together.   We provide the right tools, products and support to our business 
partners so that they may successfully deliver sophisticated solutions for their customers.  We 
recognize that we greatly extend our reach and influence by cultivating channel partner 
relationships both inside and outside of Hexagon.   

TEAM. As an employer, we recognize that the success of our business is the result of our highly 
motivated and collaborative staff.  At Hexagon Geospatial, we celebrate a diverse set of people 
and talents; and we respect people for who they are and the wealth of knowledge they bring to 
the table. We retain talent by fostering individual development and ensuring frequent 
opportunities to learn and grow.    

HEXAGON. Hexagon Geospatial plays a key role in Hexagon’s multi-industry focus, leveraging 
the entire portfolio for a wide variety of geospatial needs. Hexagon is a leading global provider of 
design, measurement and visualization technologies.  Synergistic thinking is encouraged 
across all levels and functions at Hexagon companies, so that we all respond better and faster 
to our shared customer’s needs. 

For more information, visit www.hexagongeospatial.com (http://www.hexagongeospatial.com) 
and www.hexagon.com (http://www.hexagon.com). 

http://www.hexagongeospatial.com/
http://www.hexagon.com/
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S E C T I O N  1  

Introduction 
This tutorial is based upon a project that was carried out by the City of Hamilton in Ontario, 
Canada. The city needed a city-wide digital elevation model (DEM) to act as a foundation for a 
variety of other GIS-related projects across a number of departments. 
 

Participants 

The GIS Services Department is responsible for a wide variety of corporate functions. These 
functions include acquiring, maintaining, and disseminating geographical features; maintaining 
an active web map server (http://map.hamilton.ca); delivering maps to both internal and 
external clients; and providing GIS implementation services to various city departments.  
 

The Study Area 

The tutorial data sets have been provided by the City of Hamilton, Canada, and Peel Region, 
Canada. The data includes a blended map view for the entire area of the City of Hamilton 
(including the six former municipalities: Hamilton, Stoney Creek, Ancaster, Dundas, Glanbrook, 
and Flamborough).  The total area of the City of Hamilton, according to Statistics Canada, is 
1,117km

2
; however, for the purpose of this tutorial you will be working with a 5 KM by 5 KM 

Study Area. 
 

The Case Study 

The XYZ point data that was used as the starting point for this project was extracted from the 
city’s current digital ortho-photographs at 10-meter intervals and converted into text files. These 
files were then imported into Grid Analysis using the XYZ translator. Once the data resided in 
Grid Analysis, the Interpolate IDW and Smooth commands were used to produce a digital 
elevation model for the entire city.  
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The Shaded Relief command was then used to create a shaded relief model, which in turn was 
used in conjunction with the DEM to produce a blended grid layer. The final step in the process 
used the Isoline command to produce 2.5 meter contours. 

 

To date, this data has been utilized in a variety of different contexts, such as Viewshed analysis 
to show the coverage of radio towers for Hamilton’s Emergency Services, calculating land 
depressions to locate potential standing water sites for use in the West Nile Virus Program, and 
spill and slope analysis for the Emergency Operation Centre’s emergency preparedness.  

In this tutorial, you are going to follow a similar workflow; however, instead of producing a 
10-meter DEM for the entire city, you are going to produce a 2.5-meter DEM for a 25-square-KM 
area within the City of Hamilton.  
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Once this DEM has been created, you are going to use the Group command to create a 
Choropleth map of elevation, use the Shaded Relief and Calculator commands to produce a 
shaded relief model, use the Blend command to create a shaded relief model that is tinted by 
the colors present in the Choropleth map of elevation, and, finally, use the Isoline command to 
produce 5-meter contours that match the color gradation in the Blended map. 
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Tutorial Text Conventions 

There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb panel, click Ccc > Ddd. 

 Dialog box names, field names, and button names are depicted using Bolded Text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
Italicized Text. 
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S E C T I O N  2  

Part 1: Getting to Know the Workspace 
Grid Analysis is completely integrated with the GeoMedia Desktop and is available when 
GeoMedia Advantage or GeoMedia Professional tiers are used. 

1. Launch GeoMedia Desktop, and choose Open an existing GeoWorkspace (More Files) from 
the Welcome menu. 

2. Use the open dialog box to browse to \Grid Analysis Tutorials\Customer-Based 
Tutorials\Points to DEM to Blended.  

  The installer for this tutorial automatically puts the data in this folder. Select the 
Hamilton.gws GeoWorkspace file, and click Open. 

3. If a GeoMedia error message requests the name of the database files, browse to locate the 
required connections (\Grid Analysis Tutorials\Customer-Based Tutorials\Points to DEM to 
Blended), click Open, and click OK in the error message box. 

The City of Hamilton GeoWorkspace has two connections: 

 A Microsoft™ Access read-only database connection to Hamilton.mdb (named Map 
Areas), containing some locational feature classes. 
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 A Microsoft™ Access read-write database called Points_to_Blended. This connection 
contains two Study Areas, specifically Entire City and Map 3. The Study Area Entire City 

contains the blended grid results of the work completed by the City Of Hamilton. You will use 
this file for visualization purposes only (that is, to gain an understanding of what can be 
accomplished using Grid Analysis). The Study Area Map 3 contains a single grid file. This 

grid file is the starting point for this tutorial, and it will be used as the foundation for building all 
of the derivative maps. 

 

The Hamilton GeoWorkspace has been set up to display two feature classes (namely, 
CityGrid_25km and Grid_25km_Label). The City of Hamilton uses this grid to logically 
divide the city into 25-square-km areas, with each grid having a numeric label. You are 
going to be working in grid area three. However, before beginning, let’s examine the final 
grid layer that the City of Hamilton created using Grid Analysis. 

4. On the Grid tab, in the Study Area panel, click List to display the Study Area List. 

5. Click the + symbol beside the Entire City text to display the contents of the Study Area.  

  The Entire City Study Area only has one grid file (Blended). 

6. Right click on the grid layer named Blended, and when the context menu appears, select 
Display in Map Window. 
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7. Use the GeoMedia legend to move the Blended entry to the bottom of the legend. 

 

This grid layer contains a shaded relief model for the entire city of Hamilton at 10 meters of 
resolution. Notice how this shaded relief model has been tinted. Areas of lower elevation are 
made up of light green hues, and areas of higher elevation are made up of red hues. 

Shaded relief models are a representation of a DEM. These representations provide insight 
about a surface. 
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8. Use the tools in GeoMedia Desktop to zoom into area 64. 

 

The linear feature running east-to-west is the Niagara Escarpment, which is the most 
prominent topographical feature in southern Ontario. 

The Niagara Escarpment has origins dating back into geological history some 430 to 450 
million years, a time when the Hamilton area lay under a shallow warm sea. This sea lay in 
a depression of the earth's crust, the center of which is now the State of Michigan. Now 
geologically known as the Michigan Basin, the outer rim of this massive saucer-shaped 
feature governs the location of the Niagara Escarpment.  

In the shape of a gigantic horseshoe, the Escarpment can be traced from near Rochester, 
New York, south of Lake Ontario, to Hamilton, north to Tobermory on the Bruce Peninsula, 
beneath the waters of Lake Huron, to appear again on Manitoulin Island, across northern 
Michigan, and down the west side of Lake Michigan into the State of Wisconsin. 

9. Click the GeoMedia Fit All icon to zoom to extents. 
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10. Use the tools in GeoMedia Desktop to zoom into area 50. 

 

In southwestern Ontario there are many oval-shaped hills. Called drumlins, these hills were 
made by the glacier that covered most of the continent of North America 430 to 450 million 
years ago. Their longer axes are always parallel to the direction of the ice movement; 
therefore, Drumlins tell us the directions in which various parts of the continental glacier 
moved in southwestern Ontario. 

11. Use GeoMedia Desktop to zoom to extents. 

12. Use GeoMedia Desktop to turn off all the legend entries. 

13. Use the Study Area List dialog box to set the active Study Area to Map 3. 

14. Use the Study Area List dialog box to display the Grid layer named Points (under the Map 
3 Study Area) in the Map window. 

15. Click the Fit All icon to zoom to extents. 

You will see the points as black through grey dots, spaced about every 10 meters. This data 
set included break lines, road lines, and some ridge and channel points. Between the points 
the layer is blank. 
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16. Have a closer look at the data by using the GeoMedia Desktop magnifying glass  to 
zoom in on the data points. Click somewhere near the center of the map approximately four 
times so that the individual points are visible. 

 

17. On the Grid tab, in the Layer panel, click Cell Magnifier. This will turn the pointer into a 
cross hair. 

18. Click on a grey cell, which represents an elevation point, and a small window will open with 
a 5-by-5 grid of cells with the cell you clicked on in the center. 

 

You can read the elevation value of the point that you clicked on and see it in context with its 
neighbors. If you right click on the cell magnifier window, you can change the size of the grid 
cell view from 3-by-3 up to 11-by-11.  

The cells in the window that have no associated elevation value (that is, those locations for 
which there was no elevation point sampled in the input data set) contain the value VOID. 
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VOID is a special value that represents the absence of data (sometimes called a NULL 
value).  

Many other grid systems use a large negative number, such as -9999, to represent NULL 
data, but Grid Analysis has a special value called VOID so that your value range is not 
constrained by the artificial NULL value. 

19. Spend some time exploring the map window using the Cell Magnifier tool. When you are 
finished, press the ESC key to cancel the tool. 

20. Click Close on the Cell Magnifier window. 

21. Click Fit All once again. 
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S E C T I O N  3  

Part 2: Creating a DEM from a Sparse Matrix of 
Points 
This Canadian elevation data set is in meters because the Metric system is used in Canada. In 
the United States, many data sets are in feet or Survey feet. If you wanted to convert the 
elevation data to feet, just use the Calculator command to multiply the meter data by 0.3048 
(the approximate number of meters in a foot). For this tutorial, you will work in meters. 

When data sets are imported into Grid Analysis using the XYZ importer, the data units of the 
incoming values are set to None (or unknown). You need to modify this and set the data units 
for the point map to meters.  

1. On the Grid tab, in the Layer panel, click Layer > Information; then select the Points layer, 
or right click on the Points layer name in the Study Area List, and choose Information. 

2. In the Information window, use the Data units drop-down list to set the data units to 
Meters. 

 

3. Click OK to dismiss the window.  

  This change is automatically saved to the file when you click OK. 
 

Interpolating Data: Using the IDW Command 

In grid analysis, DEMs are continuous data sets, but as you have seen, the grid layer you 
created when you imported the 10-meter-spaced elevation points has VOID cells between the 
points of known elevation. To fill in the gaps between points and to generate a continuous data 
set, use one of the Interpolation commands. 

It may take a lot of experimentation to arrive at the ideal settings for your data set. Each of the 
commands used in this workflow has several options that interact with each other and with the 
nature of the input data. The settings used here will not necessarily work with another data set. 
They were arrived at through an iterative process of testing different options and observing the 
results.  
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With large data sets, such as an entire city sampled at 10-meter intervals, it is a good idea to 
begin with an area that has representative terrain from the entire area to be interpolated. Fine 
tune the settings on this subscene before applying the workflow to the entire data set. Options to 
vary include the cell resolution at which you import the data, the size of the interpolation window, 
the size of the smoothing window, and the method of shading. 

In grid analysis and processing, "continuous" data sets are derived from sparse data sets 
through interpolation. A variety of algorithms is used to estimate the values of cells with 
unknown values based on their proximity to cells with known values. Some algorithms estimate 
unknown values based on the trend in values of nearby cells relative to their distance from the 
target cell. 

Grid Analysis currently has four data interpolation algorithms, with more planned for the future. 
The four data interpolation commands, IDW (Inverse Distance Weighting), Ordinary Kriging, 
Ordinary Kriging Suite, and Spline, have fairly complex interfaces that require you to supply 
several parameters. In each case, it is assumed that you have a good understanding of your 
data set and of data interpolation algorithms in general. The more knowledge you have, the 
better the results of the interpolation commands. 

IDW (Inverse Distance Weighting) is a classic gravity model. For each target cell, an 
interpolated value is computed based on the values of data cells in a defined neighborhood and 
the distance between each data cell and the target cell. Two weighting methods are available. 
When the Inverse weighting method is used, the interpolated value is equal to the sum of the 
ratio of each data value and its distance to the target cell, divided by the sum of the reciprocals 
of the distances. When the Inverse Squared weighting method is chosen, the square of the 
distances, rather than the distances, is used. Data points closer to the target cell contribute 
more to the estimated value than do more distant values. Squaring the distance values 
enhances local effects. 

Kriging is a specialized interpolation algorithm used to predict the location of a body or structure, 
or the extent of a phenomenon that is continuous and discrete. For example, it can be used to 
predict the location of a plume of groundwater contamination, a body of ore, or an earthquake 
epicenter. It should not be used to predict a surface, such as ground elevation or temperature. 

The Spline command is used to interpolate a continuous surface from sparse data points using 
the Completely Regularized Spline method of Mitasova and Mitas (1993). It is a variant of the 
Thin Plate Spline (TPS). 

The command models the behavior of a material with a specified amount of tension as it is 
draped over a set of known points. Unknown values are determined by plotting their positions on 
the surface. 

The following are "rules of thumb" for Grid Analysis users who are already experienced with 
raster GIS and who have a good knowledge of the limitations of their data set: 
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IDW 
 Use for high density and/or regularly spaced data points. such as elevation data, 

temperature data, rainfall data, or data from any continuously varying surface. 

 Use to fill in small gaps in satellite data, aerial-photography mosaics, or DEM mosaics. 

 Use when there is a low degree of confidence in the exactness of the original data. 

 

Ordinary Kriging 
 Use for very sparse data (<1000 data points), such as core samples, well logs, ground 

water measurements, seismic recordings, clustered data, and random points. 

 Use when the distance at which data points become independent is known. 

 Use for spatially correlated data or data for which there is a trend (ground water plumes, 
ore or other geostratigraphic bodies, seismic measurements, and so on). 

 Use when there is a high degree of confidence in the exactness of the original data. 

 Use to predict (interpolate or extrapolate) the distribution or structure of a phenomenon. 

 

Spline 
 Use to interpolate continuous surfaces from well distributed, sparse to very sparse, 

data. Data should be thinned if it is too dense or if there are a lot of redundant values, 
such as along rasterized contours. 

 Use to model a continuous surface from sparse data based on general trends (that is, 
relatively smooth results) in the surface, rather than exactly predicting specific points. 

Data interpolation, by its very nature, is fraught with "gotchas" (common mistakes based on 
invalid assumptions). You must understand the limitations of the data interpolation methods and 
the data used as the basis for interpolation. Be aware that data interpolation is merely an 
estimation based on probability. The results are only as reliable as the input data and the 
applicability of the interpolation method. If poor quality data is used, poor quality estimations will 
result. You should "ground truth" results before using them to make decisions that may have 
social or economic consequences. 

Many users try to generate DEMs from contour data with the assumption that contours are a 
highly accurate and reliable data source. In fact, most contours layers are just estimations and 
generalizations, making their reliability as a data source quite low. 

It is absolutely critical that you choose the appropriate cell resolution for the interpolation. If data 
points are separated by 100 meters or more, do not expect to obtain sub-meter accuracy in the 
interpolated results. 

The Spline command has a limitation that IDW and Kriging do not. The Spline algorithm 
generates a curved surface that may result in changes to surface volumes compared to other 
interpolation techniques. 
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For more information on data interpolation and a detailed explanation of the Grid Analysis 
interpolation commands, refer to the appendix. 

1. On the Grid tab, in the Analysis panel, click Interpolation > IDW. 

2. Choose the Points layer as the Source layer. 

3. Set the Output precision to 0.01 Meters (centimeters).  

  The precision value should be selected carefully and logically. If sample points are 
10 meters apart, do not expect to be able to interpolate elevation values down to the 
millimeter, even if the precision of the input data is sub-millimeter, as is the case with this 
data set. In all likelihood, the data accuracy is no better than centimeters or decimeters. You 
can opt to specify Imperial data units here, and your output map will be converted to those 
Imperial units. 

4. Set the Search radius to 5 cells. 

The search radius is the maximum distance from a cell with an unknown value (that is, one 
with the value VOID) that the algorithm will search for cells with known values that will be 
used for interpolation. Searching small distances emphasizes local effects. Searching large 
distances emphasizes regional trends.  

For very sparse data, which this data set is not, it may be necessary to increase the search 
radius just to find points from which to interpolate. For very sparse data sets, it is 
recommended that the Spline command be used. 

The larger the search radius, the longer the command takes to complete. A search radius of 
5 was chosen as a trade off between quality and speed for the purposes of this tutorial. A 
larger search radius of 9 or 11 would produce significantly better results. 

5. Choose the Inverse option for the Weighting method. Both weighting methods emphasize 
local effects over regional effects, but Inverse Squared strongly emphasizes local effects 
and should be used mainly for data that is highly variable over short distances. 

6. Name the layer Interpolated Surface. 

7. Leave the Place results in map window check box checked. 
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8. Ensure that your dialog box matches the one depicted below, and then click OK to execute 
the command. 

 
 

Assessing DEM Quality: Using the Detect Edges Command 

The Detect Edges command is used to improve image quality, enhance edges, and detect 
boundaries by emphasizing small-scale, abrupt changes in continuous data. Detect Edges 
offers seven filter options that use different averaging and weighting schemes. You will use the 
Sobel option to enhance defects and artifacts in the Interpolated Surface layer. 

1. On the Grid tab, in the Analysis panel, click Zone > Detect Edges. 

2. Specify Interpolated Surface as the Source layer. 

3. Choose the Sobel filter.  

  The Sobel filter is a fairly strong edge detection filter that greatly enhances even 
subtle edges. 

4. Accept the default layer name. 

5. Leave the Place results in map window check box checked. 
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6. Click OK to execute the command. 

 

To properly view the results of the Sobel filter, you should change the color sequence. 

7. On the Grid tab, in the Layer panel, click Layer > View Legend. 

8. Choose Detect Edges Result Layer from the Layer drop-down list. 
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9. Click on the first legend entry; scroll to the last legend entry, and shift-click to select all 
legend entries. 

 

10. Right click on the legend, and choose Color Sequence. 

11. Change the Distribution to Change in zone area and click OK. 

 

12. Click Apply. 

13. Click Close. 

14. Zoom in on the map window.  
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Note the contours and a regular texture in some of the flatter areas. The textures are very 
subtle anomalies that result from the high precision and small interpolation window used. 
The contours represent real contours that were probably used to generate some of the 
original data set. 

 

A simple pass with a smoothing filter can reduce or eliminate most of these anomalies. With a 
lot of experimentation, anomalies can be removed with a combination of settings in the IDW and 
Smoothing dialog boxes.  

When interpolating large areas, begin with a small subscene (using the Subscene command) 
that is representative of the terrain and the data as a whole, and tune the IDW and Smoothing 
settings here before applying them to the entire data set. There is no magic formula. Every data 
set, cell resolution, and use will require custom settings. 
 

Smoothing Data: Using the Smooth Command 

The Smooth command "homogenizes" data by examining a neighborhood of cells to determine 
a local average. This command reduces anomalous, small-scale variations in a continuous 
surface grid layer, while preserving general trends. It removes small spikes and pits in the data. 

Data anomalies are very common in interpolation results. A smoothing algorithm is a good way 
to level them out and make the surface appear more natural, which is most desirable for good 
quality shaded relief layers. The trade off with data smoothing is that you are changing known 
data points by averaging their values with neighboring values. The IDW command maintains the 
original data values at measured locations. 
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The Smooth command moves an averaging "window" over the entire data set and assigns a 
new value to the center cell of the window based upon the average of the values within the 
window. This effectively removes local variation. The larger the moving window, the more local 
effects are "blended" into the trend within the window. Larger smoothing windows tend to 
produce better looking shaded relief layers, but the trade-off is a significant increase in 
processing time. 

1. On the Grid tab, in the Analysis panel, click Surface > Smooth to open the Smooth dialog 
box. 

2. In the Source layer name drop-down list, choose the layer named Interpolated Surface. 

3. Click the Unweighted average radio button. 

4. Click the Window shape Round radio button. 

5. Choose a Window size (diameter) of 11 cells. 

6. Choose the Mean statistic. 

7. Rename the result layer Smoothed Surface. 

8. Check the Place results in map window option. 

9. Click OK. 

 

The window size of 11 cells is a trade-off between quality and processing speed. Many different 
window sizes were tested before the value of 11 cells was selected. Note that it may take 
several minutes to run this command with a window this large. 
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Reducing Data Precision and Legend Value Explosion: 
Using the PREC Function. 

The original imported XYZ file had four decimals of precision. This is sub-millimeter precision for 
points measured every 10 meters or so. This seems to be excessively high and probably not 
realistic. This data may only be accurate to one or two decimals of precision at best, depending 
upon the measurement technique used. 

When interpolating and smoothing, it is always a good idea to work at a higher precision than 
the error of the measurement device. This higher precision gives these algorithms some 
flexibility and range in calculating values. Once the interpolation and smoothing are complete, 
the precision can be reduced to a level more in keeping with the accuracy of the measured data. 
This serves to more accurately represent the data and also greatly reduces the number of zone 
values in a map layer, thereby speeding up additional processing later in the workflow. 

You began with 181,142 zones (distinct values) in the input layer with four decimals of precision.  

  You can determine the number of zones within a grid layer using the Information 
command. The interpolation was done at two decimals of precision, resulting in 18,839 zones. 
After smoothing, the precision exploded to 2,537,299 zones with three decimals of precision. 
The Smooth command has introduced a false level of precision into the data. You will use the 
PREC function to reduce the number of zones and the precision of the data to a more realistic 
two decimals. 

1. On the Grid tab, in the Analysis panel, click Grid > Calculator. 

2. Click the prec button in the bottom-right corner of the function buttons on the Calculator. 
This will place the name of the prec function in the calculator display, place brackets after it, 
and place the insertion point between the brackets. 

3. Double click the layer named Smoothed Surface from the Available Layers list. 

4. When the name of the layer appears between the brackets, type a comma; then type the 
number 2. This means: "Set the precision of the layer named Smoothed Surface to 2 
decimals." 

5. The statement should look like this: prec("Smoothed Surface" , 2) 

6. Rename the result layer to Smoothed Surface Prec 2. 

7. Ensure that the Place results in map window check box is checked. 

8. Click OK. 

The resulting grid layer will have 18,821 zones. You have now generated a DEM that is suitable 
for creating a shaded relief layer that can also be used for surface analysis (grade, aspect, and 
curvature; flow direction, flow concentration, flow accumulation, contributing area, and 
watershed delineation; surface travel distance and shortest path analysis; true length, perimeter, 
area, and volume calculation; viewshed analysis; and contour line generation) and a multitude of 
other analyses. 
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Examining Your Data Layers: Using the Layer Profile, 
Histogram, and View Legends Commands. 

Grid Analysis has many tools to examine data and to extract information. Two useful tools are 
the Layer Profile and the Layer Histogram commands.  

The Layer Profile command displays a profile of grid layer data values along a transect for one 
or two grid layers. The transect is defined by the user by drawing it in the GeoMedia Map 
window or by selecting a feature of a linear feature class. The profile chart can be manipulated, 
different view options can be chosen, and the graphical image and the underlying data values of 
the profile can be copied to the Clipboard for use in other applications. 

1. Turn the display off for the following layers: Points, Interpolated Surface, Detect Edges 
Result Layer, and Smoothed Surface. 

2. Click the Fit All button in the map window. 

3. On the Grid tab, in the Layer panel, click Profile. 

4. The pointer will become a cross hair. Click somewhere near the center top of the map 
window; then double click near the center bottom of the map window to define a north-south 
transect. After you double click, the Layer Profile dialog box will open. 

5. Choose Smoothed Surface Prec 2 from the Source layer drop-down list. A profile of the 
transect will be displayed. The Smoothed Surface Prec 2 profile depicts the Niagara 
Escarpment very clearly. 

 

6. Choose Interpolated Surface from the Additional Layer drop-down list. A second profile will 
be displayed. The second profile shows a profile for the original surface before smoothing. 
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7. Use the cursor to zoom in on an area within the profile. Notice how the two profiles look in 
comparison to one another (that is, note that the Smoothed Surface Prec 2 profile is much 
smoother – the rapid and erupt changes in local elevation have been removed). 

 

8. Experiment with the different settings in the Layer Profile viewer; then click Done when you 
are finished. For more information on the Layer Profile tool, refer to the Grid Analysis help 
documentation. 

The View Legends command opens the View Legends window. This window is used to select 
and display the legend information for any grid layer in the active Study Area. The standard 
legend editing tools are available in the View Legends window.  

Changes made in the View Legends window can be viewed then discarded when the window is 
closed or, optionally, saved. The most useful function of the View Legends command is the 
ability to change the color or color sequence of individual or groups of zones. 

The default color scheme that is applied to the surface layers you have generated is just a 
standard black to white. You can change this by using the View Legends window.  

1. On the Grid tab, in the Layer panel, click Layer > View Legend. 

2. Choose Smoothed Surface Prec 2 from the Source layer drop-down list. 

3. Click on the first legend entry, and then scroll down to the bottom of the View Legend 
window and shift-click on the last entry. 

4. Right click on the legend, and choose Color Sequence from the context menu. 

5. Experiment with different color sequences, and observe the changes in the map window. 
Now choose a dark green for the start color (left-hand color box) and a pale yellow for the 
end color (right-hand color box), and then specify a Clockwise Path Type. 

6. Click Apply. 
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7. Click Close. 

 

The DEM in the map window will be updated to reflect this change in the color sequence. 
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Part 3: Visualizing a DEM 
The Shaded Relief command creates a shaded relief model from a continuous surface grid 
layer, such as a Digital Elevation Model (DEM). DEMs are numerical representations of the 
Earth's surface.  

Each grid cell contains a value that represents the average elevation for the area represented by 
the cell. When taken together, it is possible to simulate the effects of lighting a surface by 
analyzing the relationship of each grid cell to its neighbors by comparing the apparent 
orientation of the grid cell to that of a vector that represents a presumed angle of illumination, 
and by assigning a value and tone that models the effect of the angle of incidence made by the 
illumination vector to the surface. 

Shaded relief models can provide dramatic views of surface features and are used primarily for 
visualization and communication. Shaded relief models are map layers that simulate the effect 
of illuminating the terrain from a given angle and elevation.  

Grid Analysis employs three different shading algorithms. Choose the one that best suits the 
needs of your analysis and the quality of your data, and choose the one that gives the best 
aesthetic results. 

The Illumination algorithm requires you to input the azimuth and elevation of a point-source 
illumination.  

The Date & Time algorithm uses the layer's geographic coordinate system information, and 
user-input date and time, to simulate the lighting conditions on the surface on a cloudless day 
for the given time.  

The Smoothed algorithm applies a Low-Pass filter with user-input azimuth of illumination. While 
the Date & Time algorithm produces a Result layer based on physically possible natural lighting 
geometry, the Illumination and Smoothed algorithms allow you to create "artificially lighted" 
images. 

Shaded relief models can also be used as a diagnostic tool to assess the quality of DEMs 
because the shading highlights subtle changes in the data. As with the Sobel filter, creating a 
shaded relief model of a DEM is a recommended step in judging the success of the underlying 
interpolation process. 

In this exercise, you are going to set the data units of the Smoothed Surface Prec 2 layer, create 
a Shaded Relief model, then reduce the legend value explosion of the Shaded Relief model to 
speed further processing. 
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Visualizing Data: Using the Shaded Relief Command 

Whenever you apply a Calculator function to a map layer, the data units are set to None. This is 
done because most functions change the nature of data values, negating the data units. Even 
though this is not the case for the PREC function, the data units are still set to None. 

1. On the Grid tab, in the Layer panel, click Layer > Information. 

2. Choose the Smoothed Surface Prec 2 layer from the available layers list, and then set the 
data units in the Data units drop-down list to Meters. 

3. Click OK to close the Information window. 

You are now ready to create a shaded relief layer. 

4. On the Grid tab, in the Analysis panel, click Visualization > Shaded Relief. 

5. Click on the Smoothed tab (you can experiment with the other algorithms after you 
complete the workshop). 

6. From the Source layer drop-down list choose the Smoothed Surface Prec 2 layer. 

7. Click the Show button in the Preview Area. 

8. Pan the Source layer on the left and observe the quality of the shaded relief layer on the 
right. 

9. Click the Smoother button; then click the Show button. 

10. Pan the preview to compare the two different smooth options. The smooth options add more 
smoothing to the surface to remove anomalies not taken out by the original Smooth 
command. 

11. Experiment with different illumination angles by clicking different positions around the 
Azimuth of Illumination circle. You must click Show/Update each time you change the 
illumination angle in order to see the results of the change. 

12. Click the sun circle in the North West quadrant to return the illumination angle to 315 
degrees. 
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13. Change the Result layer name to Shaded Relief Full Prec. 

 

14. Click OK to generate a shaded relief layer. 

You should now see a fairly good quality shaded relief layer in the map window. This layer 
has 368,762 zones. This leads to far more shades of grey than the human eye can 
distinguish. 

 

Reducing Data Precision and Legend Value Explosion: 
Using the PREC Function. 

You will use the PREC function again to reduce the number of zones. The advantage in doing 
this is that you will speed up processing of any subsequent commands applied to the Shaded 
Relief model, and you will dramatically reduce the storage requirements for the Shaded Relief 
model.  

If you set the precision to two decimal places, you will reduce the number of zones to 58,666; if 
you set the precision to one decimal place, you will reduce the number of zones to 15,036. A 
total of 58,666 zones should be adequate to give a large enough tonal range to produce a good 
shade relief layer. 

1. On the Grid tab, in the Analysis panel, click Grid > Calculator. 

2. Click the prec button in the bottom-right corner of the function buttons on the calculator. 
This will place the name of the prec function in the calculator display, place brackets after it, 
and place the insertion point between the brackets. 
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3. Double click the layer named Shaded Relief Full Prec from the Available layers list. 

4. When the name of the layer appears between the brackets, type a comma; then type the 
number 2. This means: "Set the precision of the layer named Shaded Relief Full Prec to 2 
decimals." 

5. The statement should look like this: prec("Shaded Relief Full Prec" , 2) 

6. Rename the result layer to Shaded Relief. 

7. Uncheck the Place results in map window check box. 

8. Click OK. 

You have now finished generating a good quality shaded relief layer from a reasonable quality 
XYZ elevation data set. But there is still more you can do to your shaded relief layer to make it 
more appealing and to communicate more information about the terrain. The DEM you 
generated can also be used to generate a contour line feature class. You will do both these 
things in the next section. 
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Grouping Data: Using the Group Command 

The Group command divides the Source map values into sequential groups, with each group 
defining a zone in the Result layer. The Group command is often used to summarize or simplify 
complex data or to create Choropleth maps.  

The values of the Result layer can be either the lowest, middle, or highest value of the 
corresponding Source layer group. The command will, optionally, generate legend text that 
gives the range of Source layer values that resulted in each Result layer zone. The Result layer 
data values will be either fixed-point or floating-point, depending on the data type of the Source 
layer. 

You will define groups that will correspond to a set of contours which you will create in the next 
exercise. 

1. In the GeoMedia Map window, turn off the layers named Smoothed Surface Prec 2 and 
Shaded Relief Full Prec. 

2. On the Grid tab, in the Analysis panel, click Classification > Group. 

3. Choose the layer Smoothed Surface Prec 2 as the Source layer. 

4. Click the By button, and set the value to 20. This means that you are going to define groups 
of elevation values in increments of 20 meters (since the units of elevation are in meters). 

5. In the Starting from, field enter 0. In the To field, enter 280. This means that you want to 
group your data into 20-meter intervals starting at 0 and ending at 280. Therefore, potential 
groups will be 0-19, 20-39, 40-59, and so on, up to 280, which is the closest 20 that just 
exceeds the maximum elevation value of 263.87 meters. 

6. Click the Middle radio button to specify that the Assigning Value is the middle value of 
each group: 10, 30, 50, and so on. 

7. Click the Generate range labels button to assign the value range as the legend text for 
each zone in the result layer. 

8. Change the Result layer name to Elevation Classes. 

9. Leave the Place results in map window check box checked. 
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10. Click OK to execute the command. 

 

When the command completes, a Choropleth map appears in the map window with the default 
color scheme of black through white. Do not worry about changing the color sequence now; you 
will be able to improve it right in the Blending command dialog. 
 

Blending Grid Layers: Using the Blending Command 

The Blending command, which is more like a mini image processing application embedded in 
Grid Analysis, is used to create, preview, and save blended grid layer views and blending 
configurations.  

The blended view can be flattened and saved as a grid layer. The blending configuration – a list 
of the component layers, their stacking order and visual parameters – can also be saved as a 
.gbc (Grid Analysis Blending Configuration) file, and then it can be reloaded in the future to 
re-create or modify the blending. 
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1. On the Grid tab, in the Analysis panel, click Visualization > Blending to display the 
Blending dialog box. 

 

Take a moment to review the features of this dialog box. On the left-hand side are three 
tabs: Layers, Legend, and Settings. 

On the right-hand side there is a preview screen that remains active and updates 
automatically as you make changes in the tabs on the left-hand side. The preview has 
Zoom, Pan, Refresh, and Rulers options. 

In the bottom-left-hand corner are two buttons: Load and Save. These are used to load and 
save configurations. A configuration will store information about the layers and settings that 
you used to create a Blended layer. 

The Layers tab allows you to add and remove layers from the Blended layer and to toggle 
visibility on and off. The drop-down list at the top allows you to specify the current layer. 

The Legend tab gives you access to the standard legend control. You can use it to change 
colors, color sequences, and groups. The drop-down list at the top allows you to specify the 
current layer. 

The Settings tab allows you to set Opacity, Brightness, Contrast, and interaction for the 
layers. The drop-down list at the top allows you to specify the current layer. 

2. Click the Add layer(s) button to open the Add Layer(s) dialog box. CTRL-click to select the 
Elevation Classes layer and the Shaded Relief layer. 

3. Click Add to add these layers. 

4. If Elevation Classes is not on the top of the stack (layer list), click on its name, and drag it 
up so that it is listed before the Shaded Relief layer. If you wish to experiment with layer 
visibility, click the small "x" to the right of each layer to toggle the visibility of that layer. 
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5. Make sure that Elevation Classes also appears in the drop-down list above the layer list. 

6. Click the Legend tab to make it active. 

7. Click on the first legend entry in the legend; then shift-click on the last entry to select the 
entire range of zones. 

8. Right click on the legend; then select Color Sequence from the context menu that appears. 

9. Apply the same dark-green-to-pale-yellow color sequence that you used when you colored 
the DEM.  

10. Make sure you click the Clockwise radio button.   

11. Click OK. 

12. Click the Settings tab to make it active. 

This tab contains tools for changing the appearance of the active layer and for specifying the 
way that it is going to interact with the layer(s) below it. 

13. Change the Blending Mode from Normal (cover) to Blend (average). If you wish, 
experiment with the other modes before selecting Blend. Blend can also be accomplished 
using the opacity slider/value field. You may also wish to experiment with this before 
selecting Blend. 

14. The image looks a little dull or flat. It would look better if you enhanced the contrast. 

15. Select Shaded Relief from the active layer drop-down list. 

16. Use the slider or type in the Contrast field, and set the contrast to 45. 

17. Use the slider or type in the Brightness field, and set the brightness to 20. 

18. You may wish to experiment with different brightness and contrast settings. 

19. Use the Hand Pan tool and the Zoom options to explore the preview. 

20. When you are satisfied with the appearance of the Blended layer, name the result Shaded 
Choropleth. 

21. Check the Place results in map window option. 

22. Click OK to generate the Bended result layer. 
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23. Two dialog boxes will appear to inform you that the Elevation Classes and Shaded Relief 
layers have changed. Click Yes to accept the changes. The final result can be viewed in the 
Geoworkspace map window: 

 
 

Contouring Data: Using the Isolines Command 

A map of isolines is called an isopleth map. Isopleth maps are used to generalize and simplify 
maps of continuous data. Contour maps, in which the isolines are lines of constant elevation, 
are probably the most common example of isopleth maps. Other examples are isopleth maps 
showing pollutant concentration, mineral deposition, rock unit thickness, gravitational 
acceleration, atmospheric pressure, air or water temperature, crime incident frequency, salinity, 
or evapotranspiration. 

In this exercise you are going to use the DEM Smoothed Surface Prec 2 to generate contours 
which you will then display in context with the results of the Blending command in the map 
window. 

The Isolines command analyzes a grid Source layer of continuous data and returns a linear 
feature class of major and minor isolines. An isoline is a line or curve on a surface that connects 
points of equal data value. Major isolines represent major divisions of data value, while minor 
isolines represent the subdivisions. The two types of isolines are usually distinguished visually 
with major isolines shown with a greater line width than the minor isolines. 

The Isolines command creates a feature class with two attributes: "IsolineValue," which gives 
the Z or data value associated with the isoline feature, and "Major," which has value -1 when the 
isoline feature is a major isoline and value 0 when the isoline feature is a minor isoline. Both 
attributes are defined as doubles. 
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1. On the Grid tab, in the Analysis panel, click Surface > Isolines. 

2. In the Source layer drop-down list, specify the layer Smoothed Surface Prec 2. 

3. Set the Major interval value to 20. 

4. Set the Minors between majors to 3. This will automatically set the Result Interval Value 
field to 5. 

5. Set the Start value field to 0. 

6. Set the End value field to 280. These settings will then match the intervals of the 
Choropleth map that you created above, with 5-meter minor contours nestled in each 
Choropleth zone. 

7. The last setting you need to make is to specify the minimum area for which you want a 
contour to be drawn. If this is set to "0" cells, you could potentially get single cells with 
contour lines surrounding them. Set the Minimum Area to 10 Cell. 

8. Leave the default settings for Line generalizing and Smoothing. These options are more 
applicable to problem data sets where contour lines are coming out jagged. 

9. Leave the default feature class name. 

10. Check the Place results in map window check box. 

 

11. Click on the Labeling tab. 

12. Click on the Details check box so that it is unchecked. 

13. Click OK to generate the isoline feature class. 
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Changing Line Color and Line Thickness 

The default color scheme for the isolines may not necessarily complement the color sequence of 
the underlying map, as in this case where the brown contour lines seem to wash out the colors 
of the Blended result layer. 

1. In the GeoMedia Map window legend, double click on the style icon for the isoline entry to 
open the Legend Entry Properties dialog box. 

2. Double click in the Style column for Major isolines. 

3. On the Select Style dialog, click the Color button, select black instead of brown, and click 
OK. 

4. Change the Width to 2.000 pt. 

5. Click OK. 

6. Double click in the Style column for the Minor isolines. 

7. On the Select Style dialog, click the Color button, select black instead of brown, and click 
OK. 

8. Change the Width to 1.000 pt. 

 

9. Click OK to apply the changes to the appearance of the isoline feature class. 

10. Observe the results in the map window. Pan and zoom as you wish, and then click the Fit 
All button. 

  The Isoline command in GeoMedia Desktop also populates the feature class table 
that it creates with useful information. 
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11. On the Home tab, in the Window panel, click New Data Window to display the New Data 
Window dialog box. 

 

12. Select Smoothed_Surface_Prec_2_Isoline1 from the list, and click OK to display a data 
window for this feature class. 

13. Notice that the table for this feature class has two attributes, namely, IsolineValue and 
Major. This IsolineValue field contains the elevation value in meters for each linear feature 
in this feature class, while the Major field contains a Boolean value to indicate Major line (-1) 
or Minor line (0). 

 

14. Close DataWindow1. 

15. This tutorial is complete. You can exit GeoMedia Desktop and save the changes. 

 



 

 

45 

 

S E C T I O N  5  

Appendix: Interpolation Methods – An Explanation 

Introduction 

A key advantage of grid analysis is the ability to process data over a surface. Grid surface maps 
of elevation are called digital elevation models (DEMs). They provide a continuously varying 
elevation surface that represents the terrain of the area of study.  

DEMs can be used to determine surface characteristics, such as slope, orientation, and 
elevation. DEMs can also be used for determining true surface distances, flow paths of fluids, 
and viewsheds. 
 

What is interpolation? 

In grid analysis and processing, "continuous" data sets are derived from sparse data sets 
through interpolation.  

A variety of algorithms is used to estimate the values of cells with unknown values based on 
their proximity to cells with known values. Some algorithms estimate unknown values based on 
the trend in values of nearby cells relative to their distances from the target cell. 
 

Who might use data interpolation? 

For many professionals, such as civil engineers, landscape planners, military planners, aircraft 
simulation builders, radio communications planners, visibility analysis planners, hydrologists, 
groundwater hydrologists, environmental remediators, mineral explorers, seismologists, and 
cartographers, data such as elevation, chemical concentration, or intensity data is only available 
as contours or discrete points; however, many types of analysis, such as terrain modelling, 
hydrological modelling, or concentration prediction, require continuous data sets. 
 

What do all those options in the command dialog box do? 

Grid Analysis currently has three data interpolation algorithms, with more planned for the future. 
The three data interpolation commands, IDW (Inverse Distance Weighting), Ordinary Kriging, 
and Spline, have fairly complex interfaces that require you to supply several parameters.  

In each case, it is assumed that you have a good understanding of your data set and of data 
interpolation algorithms in general. The more knowledge you have, the better the results of the 
interpolation commands. 
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IDW 

IDW (Inverse Distance Weighting) is a classic gravity model. For each target cell, an 
interpolated value is computed based on the values of data cells in a defined neighborhood and 
on the distance between each data cell and the target cell.  

Two weighting methods are available. When the Inverse weighting method is used, the 
interpolated value is equal to the sum of the ratio of each data value and its distance to the 
target cell, divided by the sum of the reciprocals of the distances. When the Inverse Squared 
weighting method is chosen, the square of the distances, rather than the distances, are used. 
The following shows the IDW formula. 

 

Data points closer to the target cell contribute more to the estimated value than do more distant 
values. Squaring the distance values enhances the proximity effect. The IDW dialog box is 
shown below. 

 

Refer to the following table for an explanation of the command interface of this dialog box: 

Source Layer 
Name 

The name of the sparse data grid layer. Unknown values are encoded as 
VOID. If the data is stored in a feature class, the grid layer contains 
indexed cells which act as pointers to the feature class. 
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Source Attribute When the data grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to be interpolated. 

Mask Layer Name The name of a grid layer used to restrict the interpolation to those cells 
that correspond to the cells with a non-VOID value. VOID values in this 
layer represent cells that are not to be included in the interpolation. For 
example, the user might want only to interpolate cells that fall within a 
county. 

Mask Attribute When the mask grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to act as a mask. 

First Pass Grid 
Spacing 

This value is normally set to "1"; however, to quickly process a very large 
data set, set the first pass grid spacing to a value between 2 and 10. The 
higher the value, the faster the results, but the lower the quality. Setting 
the first pass grid spacing to other than "1" results in a two-pass process 
in which a grid of values is interpolated first, and then it is used as a basis 
to interpolate the remaining values. 

Output Precision Specifies the precision, units, and data type of the output grid layer. We 
recommend setting the precision no higher than 100 times the precision 
of the input data. For example, for 10-foot contours, the output precision 
should be no more than 0.1 feet. A high precision value can lead to 
"legend value explosion," which will increase the time of processing 
without an appreciable gain in data quality. If the data values are 
measured in a unit that is not available from the units drop-down list, 
specify "None." 

Search Radius Specify the distance from the target cell that will be searched for known 
values. All known values within this radius (neighborhood) will be used to 
estimate the unknown value. This value should be chosen based on the 
density of the data and on surface variability. For relatively smooth areas, 
a large search radius can be used. If the area is rough (highly variable), 
then a smaller search radius is recommended. 

Weighting Method 
"Inverse" 

Nearby values are emphasized more than distant values. Use this option 
if the surface is relatively smooth. 

Weighting Method 
"Inverse Squared" 

Nearby values are strongly emphasized over more distant values. Use 
this option if the surface is rough (highly variable). 

 

 



Appendix: Interpolation Methods – An Explanation 

 

 

48 

 
 

 

Ordinary Kriging 

Kriging is a specialized interpolation algorithm used to predict the location of a body or structure, 
or the extent of a phenomenon that is continuous and discrete. For example, it can be used to 
predict the location of a plume of groundwater contamination, a body of ore, or an earthquake 
epicenter. It should not be used to predict a surface, such as ground elevation or temperature. 

This command applies the Ordinary Kriging method to a grid layer of sparse data to predict 
unknown values based on regression trends in irregularly distributed known values. Ordinary 
Kriging relies on a variogram to determine the distance at which data points become 
independent of one another. At this time, there is no display of the variogram in Grid Analysis. 

A variogram summarizes the relationship between differences in pairs of measurements and the 
distance of those measurement points from each other. It is used to determine the distance 
(range) at which points no longer influence one another (independence). In highly variable data, 
the range is short; in data with a broad trend, the range is larger. The Ordinary Kriging dialog 
box is shown below.  

 

The following table explains the command interface parameters: 

Source Layer 
Name 

The name of the sparse data grid layer. Unknown values are encoded as 
VOID. If the data is stored in a feature class, the grid layer contains 
indexed cells which act as pointers to the feature class. 

Source Attribute When the data grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to be interpolated. 
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Mask Layer Name The name of a grid layer used to restrict the interpolation to those cells 
that correspond to the cells with a non-VOID value. VOID values in this 
layer represent cells that are not to be included in the interpolation. For 
example, the user might want only to interpolate cells that fall within a 
couty. 

Mask Attribute When the mask grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to act as a mask. 

Output Precision Specifies the precision, units, and data type of the output grid layer. We 
recommend setting the precision no higher than 100 times the precision 
of the input data. For example, for 10 ppm, the output precision should be 
no more than 0.1 ppm. A high precision value can lead to "legend value 
explosion," which will increase the time of processing without an 
appreciable gain in data quality. If the data values are measured in a unit 
that is not available from the units drop-down list, specify "None." 

Data Model: 
Spherical/ 
Exponential 

Apply either a spherical model or an exponential model to fit a line to the 
variogram. This line will be used to predict the unknown value based on 
distance to the known values defined by the Range parameter. If the user 
plots the variogram of the data in a third party application, the choice of 
data model can be determined by fitting one of these models to data 
points. 

Range The distance, in number of cells, at which the data points become 
independent. By default, this is the length of the map, meaning that all 
points are spatially correlated. This value should be chosen based on the 
density of the data and on surface variability. For relatively smooth areas, 
a large range can be used. If the area is rough (highly variable), then a 
smaller range is recommended. If the user plots the variogram of the data 
in a third party application, the range can be determined by identifying the 
distance at which the sill occurs. 

 
 

Spline 

The Spline command is used to interpolate a continuous surface from sparse data points using 
the Completely Regularized Spline method of Mitasova and Mitas (1993). It is a variant of the 
Thin Plate Spline (TPS). 
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The command models the behavior of a material with a specified amount of tension as it is 
draped over a set of known points. Unknown values are determined by plotting their position on 
the surface. The Spline dialog box is shown below.  

 

The following table explains the command interface parameters: 

Source Layer 
Name 

The name of the sparse data grid layer. Unknown values are encoded as 
VOID. If the data is stored in a feature class, the grid layer contains 
indexed cells which act as pointers to the feature class. 

Source Attribute When the data grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to be interpolated 

Mask Layer Name The name of a grid layer used to restrict the interpolation to those cells 
that correspond to the cells with a non-VOID value. VOID values in this 
layer represent cells that are not to be included in the interpolation. For 
example, the user might want only to interpolate cells that fall within a 
county. 

Mask Attribute When the mask grid layer contains pointers to a feature class, this 
parameter is used to select the feature class attribute to act as a mask. 
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Block Radius The radius of a square, in cells, within which the Spline equation is 
computed and applied to all VOID cells in the block. The larger the value, 
the faster the operation, but the blockier the results. A radius of "0" 
calculates a new spline for every cell on the map. A radius of "1" 
calculates an equation and applies it to a 3x3 square, a radius of "2" 
calculates an equation and applies it to a 5x5 square, and so on. Values 
larger than "2" typically produce unusable results. 

Overlap Radius The radius of the square, beyond the Block Radius, in which the Spline 
command will search for values to calculate the equation of the spline. 

Sufficient Samples The number of non-VOID values inside the Block Radius plus Overlap 
Radius window that is sufficient to calculate the Spline equation. The 
command searches the window until the Sufficient Samples number of 
data points are found. When the window contains fewer than the 
Sufficient Samples number of non-VOID values, the Spline is computed 
using the lesser number of input values. 

Tension Defines the behaviour of the spline as it is draped over the known points. 
Decreasing the tension value (0<t<1) makes the model behave as a 
flexible membrane (resulting in values that approach the local average), 
while increasing the tension value (t>1) makes the model behave as a 
stiff metal sheet (resulting in values that approach the regional average). 

Output Precision Specifies the precision, units, and data type of the output grid layer. We 
recommend setting the precision no higher than 100 times the precision 
of the input data. For example, for 10 foot contours, the output precision 
should be no more than 0.1 feet. A high precision value can lead to 
"legend value explosion," which will increase the time of processing 
without an appreciable gain in data quality. If the data values are 
measured in a unit that is not available from the units drop-down list, 
specify "None." 

 
 

How do I know when to use which interpolation command? 

Users who are unsure of which interpolation method to use should consult the Grid Analysis 
help topics in the GeoMedia Help: Start > All Programs > Intergraph GeoMedia Desktop 
2014 > User Documentation > Help.  

The following are "rules of thumb" for Grid Analysis users who are already experienced with 
raster GIS and who have a good knowledge of the limitations of their data set: 
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IDW 
 Use for high density and/or regularly spaced data points, such as elevation data, 

temperature data, rainfall data, or data from any continuously varying surface. 

 Use to fill in small gaps in satellite data, aerial-photography mosaics, or DEM mosaics. 

 Use when there is a low degree of confidence in the exactness of the original data. 

 

Ordinary Kriging 
 Use for very sparse data (<1000 data points), such as core samples, well logs, ground 

water measurements, seismic recordings, clustered data, and random points. 

 Use when the distance at which data points become independent is known. 

 Use for spatially correlated data or data for which there is a trend (ground water plumes, 
ore or other geostratigraphic bodies, seismic measurements, and so on). 

 Use when there is a high degree of confidence in the exactness of the original data. 

 Use to predict (interpolate or extrapolate) the distribution or structure of a phenomenon. 

 

Spline 
 Use to interpolate continuous surfaces from well distributed, sparse to very sparse, 

data. Data should be thinned if it is too dense or if there are a lot of redundant values, 
such as along rasterized contours. 

 Use to model a continuous surface from sparse data based on general trends (that is, 
relatively smooth results) in the surface, rather than exactly predicting specific points. 

 

Should I use a combination of commands? 

It is rare to be able to use the interpolation commands independent of other Grid Analysis 
commands. Other Grid Analysis commands are commonly used to pre- and post-process grid 
layers as part of data interpolation. The following commands are most commonly used with the 
Interpolation commands: 

 Random Sample: to reduce the number of data points, particularly if there are a lot of 

redundant points. 

 Local Scan: to smooth the interpolated results prior to data analysis. 

 Detect Edges: to search for anomalies, such as edges or noise. 
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How do I make a mask to speed up processing? 

Often, there are areas of the input map for which you do not want to interpolate values (for 
example, lakes, neighboring counties, or areas for which there is already more reliable data). A 
masking grid layer can be specified to omit those cells from the interpolation.  

Only those cells of the input map that correspond spatially with non-VOID cells of the mask map 
are included in the interpolation. Cells corresponding to the VOID cells of the mask map are 
ignored. The following is an example of a masking grid layer. In this example, VOID cells are 
colored black, and non-VOID cells are colored white for visualization purposes. Cells with the 
value VOID will be left out of the interpolation. 

 

Mask grid layers can be created in many different ways: 

 Draw the mask using the Edit window drawing tools. 

 Rasterize a feature class containing a polygon or polygons defining the mask area. 

 Use the Recode command on an existing grid layer containing regions that define the 

mask. 

An alternative to masking out a region is to use the Subscene command to crop the data to 
encompass only the area of interest. 
 

Are there any "gotchas"? 

Data interpolation, by its very nature, is fraught with "gotchas" (common mistakes based on 
invalid assumptions). You must understand the limitations of the data interpolation methods and 
of the data used as the basis for interpolation. Be aware that data interpolation is merely an 
estimation based on probability.  

The results are only as reliable as the input data and the applicability of the interpolation 
method. If poor quality data is used, poor quality estimations will result. You should "ground 
truth" results before using them to make decisions that may have social or economic 
consequences. 
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Many users try to generate DEMs (Digital Elevation Models) from contour data with the 
assumption that contours are a highly accurate and reliable data source. In fact, most contour 
layers are just estimations and generalizations, making their reliability as a data source quite 
low. 

It is absolutely critical that you choose the appropriate cell resolution for the interpolation. If data 
points are separated by 100 meters or more, do not expect to obtain sub-meter accuracy in the 
interpolated results. 

The Spline command has a limitation that IDW and Kriging do not. The Spline algorithm 
generates a curved surface that may result in changes to surface volumes compared to other 
interpolation techniques. 
 

Is my data suitable for my intended application? 

One of the most common problems in grid analysis based on surfaces or distributions estimated 
from sparse data is that the data from which the interpolated surface was created is either of 
poor quality or is not precise enough for the intended application. The results of interpolation of 
these unsuitable data sets are then used to make important decisions that affect people's lives 
or livelihoods. 

Data that was sampled at low resolution (for example, USGS SDTS 30m DEMs) should not be 
used for high-resolution analysis (for example, 1m). Some analysts try to use data that was 
originally sampled at low resolution to perform high-resolution analysis. The lower the resolution 
of a grid data set, the more uncertain the value at any given location. This uncertainty is 
compounded when unknown values are interpolated from low-resolution data. 

Interpolating from contours presents many problems. Most contours are best estimates of the 
location of the isoline (contour line). This uncertainty is compounded when the contour lines are 
rasterized, particularly at low resolution.  

A contour line is an infinitely thin line, whereas a grid cell spreads that infinitely thin line over an 
area that is as broad as the cell resolution. Rasterized contour lines tend to "flood" the 
interpolation equations with too many redundant values, leading to terracing or over/under 
estimates of the unknown inter-contour cell values. 

Before applying a data interpolation command, you should be aware of the positional accuracy 
and measured precision and accuracy of the input data. If you are uncertain of the data 
collection method, then you should be cautious when applying the results. 

None of the three interpolation methods currently available with Grid Analysis can handle 
anisotropic (a phenomenon having different properties in different directions) data; this is 
particularly true of the Ordinary Kriging command, which should only be applied to isotropic 
data. 
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What can I do to make my data suitable? 

The short answer to this question is "nothing." It is not really possible to "fix" bad data. However, 
the quality of the interpolated output from poor quality data can be improved. 

For contour data, use the Random Sample command to extract approximately 1/3 to 1/10 of the 
number of data points. This will reduce the data redundancy inherent with rasterized contour 
data. 

With most Grid Analysis commands, if the input data is of type fixed, the output data will be of 
type fixed. Fixed point data may not provide sufficient precision to estimate a continually varying 
surface of values between the known data points.  

Use the Calculator command to "float" the fixed point input values before running an 
interpolation command. When applying an interpolation command to the new floating point 
values, use the precision control field to set the number of decimal places to give no more than 
two orders of magnitude greater precision than the original fixed point data. 

Change the scale of the analysis. If 30-meter data is all that is available, then change the scale 
of the analysis to 30 meters or more. 

Obtain better data. This is often a costly option, but may result in savings in the long run if the 
results of the interpolation and subsequent analysis are more accurate. 
 

How do I determine the optimum settings before running the 
interpolation? 

By their nature, interpolation commands require a considerable amount of time to execute. 
Unfortunately, the settings for each command often require some fine tuning before acceptable 
results can be achieved. This may involve running the command several times until satisfactory 
results are achieved. Running an interpolation command multiple times on a large data set is 
usually too time consuming to be an acceptable way of determining the correct setting values. 

One way to test different settings quickly is to extract a small representative area of the input 
data grid layer and to run the interpolation command multiple times on that, refining the settings 
with each execution.  

To do this, use the Subscene command. To use Subscene, a layer where non-VOID cells 
represents the region of interest is required as a reference. This layer can come from a 
rasterized feature class, a new grid layer, or an existing grid layer defining a subarea of the data 
grid layer. 
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Simple Methods for Analyzing an Interpolation. 

At first glance, interpolation results can look good; however, further analysis may reveal 
anomalies in the data that make the results unusable. There are three very simple techniques to 
determine the quality of interpolation results: 

 Change the color sequence. 

 Hi-pass filter the results. 

 Generate a shaded relief layer. 

 

Color Sequences 

A simple change to the color sequence of a grid layer can emphasize changes in the data and 
reveal anomalies. Color sequences are applied in three different distribution types along three 
different vectors through the color space defined by the color sequence. The following figure 
shows the interpolation results with the default color scheme and a color scheme that enhances 
data anomalies. 
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To reveal data anomalies, set the color sequence to start and end at adjacent colors on the 
color palette, set the Path type to either clockwise or counterclockwise, whichever one yields 
the broadest spectrum of colors, and then set the Distribution to emphasize changes in the 
zone area. Adjust the color sequence to test the effects of different distributions, path types, or 
sequences. The following Color Sequence dialog box shows a color sequence that emphasizes 
anomalies in interpolation results. The sequence runs counterclockwise through the full width of 
the spectrum and is applied based upon changes in the number of cells occupied by a given 
value (zone) numerically through the legend. 

 
 

Filter 

The Filter command has a battery of edge detection filters that reveals edges, spikes, pits, and 
other data anomalies. The Sobel filter is a good general-purpose filter for this application. In the 
following example, the Sobel filter reveals high frequency changes in interpolation results, such 
as spikes and edges. The Sobel filter was applied to the Spline results, as shown below. 

 
 

Shaded 

The Shaded Relief command creates a shaded relief layer from elevation data by simulating 
the effect of shining a light across a surface. The result will allow you to visualize the surface 
quality (see the graphic below). This technique need not be restricted to elevation data. 
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The Shaded Relief command can also be used to visualize anomalies in an interpolated 
continuous surface. The Shaded Relief command was applied to the Spline results. 
 

Workflows for Improving Results 

Smoothing Results 

Interpolation algorithms do not always produce clean results. Often minor anomalies (over/under 
shoots) occur when an estimated value is much higher or lower than the surrounding values.  

Smoothing the interpolation results can mitigate these extreme values. Run the Scan command 
with the Average modifier to smooth results. A scanning window size of 7, 9, 11, or even 15 cells 
is recommended. Use a smaller window if the original data was dense.  

Smoothing the results will average values in the scanning window and may alter known values; 
however, there is a large degree of uncertainty about the accuracy of the position and value of 
measured or derived data points in most data sources. 
 

Data Value Range 

If values of the input grid layer vary over several orders of magnitude, take the natural logarithm 
of the values, run the required interpolation operation, and then use the exponent function to 
convert the data back to normal values. The LOG() and EXP() functions are available in the 
Calculator. 
 

Hydrologic Modelling 

For users performing hydrologic modelling, run the Fill Depressions command on the 
interpolated DEM prior to running the Flow Direction command and other hydrology 
commands. 
 

Spline Parameters 

The default values for the Spline command parameters were chosen to give a good starting 
point for most data sets. However, for certain cases, the parameters should be adjusted to 
improve results. Increase the number of sufficient samples for highly variable data, and 
decrease the number of sufficient samples for very sparse data. 

The tension parameter is perhaps the most difficult to understand and apply effectively. Tension 
provides a scaling factor on horizontal distances between known data points. In general, a lower 
value should be used with widely spaced data points or with data that has low variability, and a 
larger value should be used with closely spaced data points or data with high variability. 
Decreasing the tension value causes the spline to behave as an increasingly flexible membrane, 
while increasing the tension value causes the spline to behave as an increasingly rigid surface. 

The default tension value of 1.0 is normalized for an average distance of about 10 cells between 
data points. When the mean distance between data points is significantly different than this, the 
tension value should be adjusted. 
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Selecting an appropriate tension value can be an iterative process. Start with a tension value 
which, when multiplied by the mean number of cells between data points, gives the value 10, 
and then evaluate the resulting interpolation. For example, if the mean distance between data 
points is approximately 100 cells, start with a tension value of 0.1. 

A tension value that is too high relative to the mean distance between data points produces 
interpolated values that tend toward the data mean, punctuated by the known data points, which 
appear as spikes and pits. A tension value that is too low relative to the mean distance between 
data points produces interpolated values that are outside the data range, creating peaks that are 
not present in the data and slopes at the edges of the map. 

Use higher tension for terrain with sharp changes in slope, and use lower tension for relatively 
flat terrain. If the area contains data of both types, use masks to perform separate, overlapping 
interpolations; and then average the results. 
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